
Experiment 3: Nerve Conduction 
 
Overview  
 
The interior of a cell is negatively charged with respect to the outside, and the magnitude 
of the potential difference is usually between 50 and 80 mV. Some cells, like nerves and 
muscles, can transiently reverse their membrane potentials. This event is called an 
action potential and takes place in milliseconds. During this process, the membrane 
potential goes from negative to positive and back to negative, again. In the resting cell, 
the permeability of the membrane to potassium (PK) is greater than its permeability to 
sodium (PNa). Stimulation, like synaptic activity coming from other nerve cells, can 
depolarize (make less negative) the cell membrane. Sodium channels in the cell 
membrane are sensitive to membrane depolarization and they respond by opening, 
which increases membrane’s permeability to sodium. If the depolarization reaches or 
exceeds a certain level (threshold), an action potential is produced. Action potentials 
develop because of a regenerative, positive feedback cycle. As the cell’s permeability to 
sodium increases, sodium conductance increases, and increased sodium conductance 
leads to greater depolarization of the membrane. As depolarization increases, sodium 
permeability increases again, as more voltage-sensitive channels open. With more 
channels open, sodium conductance and membrane depolarization increase until the 
membrane potential reaches the equilibrium potential for sodium. 
 
But, before the equilibrium potential for sodium is reached, two other events occur: the 
voltage-sensitive sodium channels close soon after they open, and the voltage-sensitive 
potassium channels open. With its channels open, potassium ions leave the cell and 
cause the membrane to repolarize (hyperpolarize) towards its resting level. This process 
of membrane hyperpolarization closes the voltage-sensitive potassium channels and 
reprimes the sodium channels so that they are ready to open once more.  
 
Propagation of the action potential from the site of initiation to other locations along the 
nerve cell is caused by the positive charges in the cell leaking to an adjacent 
(unstimulated) region and depolarizing that region enough to create an action potential 
there. In this way, the signal moves from one region of the axon to adjacent one, and 
ultimately to the end of the axon. Some axons are myelinated; the axon is covered with a 
series of Schwann cells, a type of glial cell which electrically insulates the axon. The 
spaces between adjacent Schwann cells are called the nodes of Ranvier, and they are 
the only regions along the axon where the membrane is exposed to the extra cellular 
fluid. The myelin insulation prevents the currents associated with action potentials from 
leaking out of the membrane until they reach a node. So, action potentials take place 
only at the nodes in myelinated cells. 
 
In this laboratory you will record action potentials from the ventral nerve cord of the 
crayfish (Procambarus clarkii). Each nerve contains hundreds of axons with different 
diameters, thresholds, and degrees of myelination. The large, myelinated axons with the 
fastest conduction velocities are known as Type A fibers. Type B fibers are also 
myelinated, but have smaller diameters and slower conduction velocities. Type C fibers 
are very small, unmyelinated axons. When a large stimulus is delivered to the nerve, 
many axons respond and the recorded potential is the summation of all the axons firing 
is recorded, This potential is known as the compound action potential (CAP). 
 



You will examine certain principles associated with nerve conduction: 
• The compound action potential—observing one or more populations of different fiber 
types, each type with similar conduction velocities. 
• Stimulus-response/axon recruitment—how the response changes with increased 
stimulus voltage. 
• The conduction velocity—you will measure how fast action potentials are conducted 
down the axons. 
• The effects of temperature—how cooling the nerve changes the conduction velocity. 
• Bidirectionality—whether crayfish ventral nerve cord conduct in both directions. 
 
Equipment Required 
 
PC computer 
iWorx/214 and USB cable 
Nerve Chamber 
AAMI cable and nerve chamber leads (red and black) 
Glass hooks 
Stimulator cable 
Grounding adapter or cable 
Crayfish (Procambarus clarkii) 
Van Harreveld’s (or crayfish) saline (in g/L, NaCl 12; KCl, 0.4; CaCl2x2H2O, 1.2, 
MgCl2x6H2O, 0.5; NaHCO3, 0.17) at two temperatures: 
• 100ml per station chilled on ice 
• 400 ml per station at room temperature 
 
Equipment Setup 
 
1 Connect the iWorx/214 unit to the computer (described in Chapter 1). 
 
2 Attach the AAMI connector on the end of the gray patient cable to the isolated Channel 
1 and 2 inputs on the iWorx/214 unit. 
 
3 Attach two color-coded nerve chamber leads to the Channel 1 inputs on the lead 
pedestal. Connect the alligator clips or sockets on the other end of the leads to the 
electrodes on the nerve bath, so that: 
• the red “+1” lead is attached to the distal (or positive) recording electrode. 
This electrode is on the thread holding the nerve in place. 
• the black “-1” lead is attached to the proximal (or negative) recording electrode. This 
electrode is on the nerve between the ground electrode and the positive recording 
electrode. 
 
Note: If the compound action potential (CAP) is recorded while the positive recording 
electrode is on the nerve, a biphasic wave is produced. As the propagating CAP passes 
the negative recording electrode, it is displayed as an upward deflection on the 
recording. This is followed by a downward deflection created as the CAP passes the 
positive recording electrode. If the CAP is recorded while the positive recording 
electrode is on the thread holding the nerve, a monophasic wave is produced.  
 
4 Plug the BNC-double banana adapter into the positive (red) and negative (black) 
sockets of the iWorx 214 stimulator. To insure the correct polarity of stimulation, check 



the side of the double banana adapter for a tab, often embossed with the letters GND. 
This is the side of adapter that goes into the negative (black) socket of the stimulator. 
 
5 Attach the BNC connector of the stimulator cable to the adapter already on the 
stimulator. 
 
6 Attach the sockets or alligator clips of the stimulator cable to the closely - spaced 
electrodes at one end of the nerve bath chamber (Figure 3-6). The one closest to the 
end of the chamber is the positive stimulating electrode. 
 
7 Attach the socket or alligator clip of the grounding lead/cable to the electrode that is 
closest to the negative stimulating electrode. The ground should always separate the 
stimulating electrodes from the recording electrodes. The other end of the grounding 
cable should be connected to the ground jack on the front or back of the iWorx 214 unit. 

 
Figure 3-6: The equipment setup to record from the ventral nerve cord. 
 
Start the Software 
 
1 Click the Windows Start menu, move the cursor to Programs and then to the iWorx 
folder and select LabScribe; or click on the LabScribe icon on the Desktop 
 
2 When the program opens, select Load Group from the Settings menu. 
 
3 When the dialog box appears, select ahk214.iws and then click Load. 
 
4 Click on the Settings menu again and select the SciaticNerve-214 settings file. 
 
5 After a short time, LabScribe will appear on the computer screen as configured by the 
SciaticNerve-214 settings in Scope mode. 
 
6 The SciaticNerve-214 settings file adjusts: 
• the stimulus amplitude to 0.25V, with adjustable increments of 0.05V. 
• the stimulus duration to 0.1ms, with adjustable increments of 0.1ms. 
• the sampling rate to 20,000 per second. 
• the sweeps to be Repetitive and timed for a duration of 30 ms. 
 
These settings can be changed by selecting Preferences from the Edit menu. 



The Dissection  
 
1 Place a crayfish in the freezer for 5 minutes. Remove the crayfish and quickly cut off 
its head. 
 
2 Remove the tail (abdomen) from the thorax by cutting around the joint (seam) 
connecting those two parts. 
 
3 Pin the tail down with the ventral surface up in the preparation dish. Push one pin 
through the shell in the first abdominal segment and a second pin through the telson. 
Cover with saline. Remove the swimmerets.  
 
4 Hold the tail and make a longitudinal cut along each side of the abdomen (below the 
hinge ridge) to loosen the ventral shell from the dorsal shell. Leave the tail fins attached 
to the dorsal exoskeleton. 
 
5 Begin at the anterior end of the abdomen and separate the ventral and dorsal halves 
of the shell from each other. Hold and lift the anterior border of the ventral shell and 
scratch with pair of scissors (or the tip of a scalper) as close as possible to the ventral 
shell. Use caution and do not cut any tissue if necessary. Try to scratch any muscle 
tissue attached to the ventral shell exclusively.  
 
6 Discard the ventral portion of the shell after reaching the telson (Figure 3-2). 

 
Figure 3-2: Diagram to show the dissection of the crayfish tail. 
 
7 You should notice the ventral nerve cord (similar to the spinal cord in humans but with 
fewer nerves!) running along the middle of the tail. Carefully hold and lift the anterior 
portion of the nerve. To separate the nerve from surrounding connective and muscle 
tissue, scratch with pair of scissors (or the tip of a scalper) as far as possible from the 
nerve. Use caution and do not cut any tissue if necessary.  
 
8 Once the nerve has been completely free, place a piece of thread under the anterior 
end of the nerve (close to the thorax). Ligate the nerve; leave a small piece of thread 
attached to the nerve. This procedure is needed to align the nerve in the nerve chamber.  
 
10 Fill the nerve chamber with saline. Lift the nerve out of the tail and place it on top of 
the nerve chamber.  
 
Important Notes  
 
1 The proximal end of the nerve (with the piece of thread) should be over the stimulating 
electrodes, and the distal end (close to the telson) should be over the recording 
electrodes. 



 
2 The thread can be secured on the edge of the bath with tacky wax or clay to prevent 
the nerve from moving when the bath is drained. 
 
IMPORTANT: Remember to keep the chamber filled with saline during 
experiments to prevent nerve drying out.  
 
Remember to drain the chamber before starting an experiment. If the fluid touches 
the electrodes they will short-circuit. 
 
Exercise 1: The Compound Action Potential 
 
Aim: To apply a brief stimulus at the proximal end of the nerve and record a compound 
action potential from the distal end. 
 
Procedure  
 
1 Check values listed the stimulator panel, which is below the LabScribe toolbar (Figure 
3-8 on page 41). The stimulus amplitude should be 0.25 V and the pulse width should be 
0.1ms. 
 
2 Remove enough crayfish saline from the nerve chamber to insure that the nerve is no 
longer contacting the solution. If necessary, carefully blot any large drops of saline from 
the recording electrodes and the nerve with the corner of a wipe. 
 
3 Click Start to stimulate and record from the nerve. LabScribe is set to use Scope 
mode and to display Repetitive sweeps. This means that the nerve will be stimulated 
again, after the preceding sweep is completed, A new recording of the nerve response 
replaces the previous sweep on the Main window. Scope will continue to stimulate the 
nerve and display new compound action potentials until the Stop button is clicked. Click 
the Stop button to preserve the latest sweep displayed on the window. 
 
4 A mark line appears on the left side of the screen to indicate the point in time when the 
stimulus was delivered to the nerve. There may be a stimulus artifact at the mark. The 
compound action potential usually reaches a peak a few milliseconds after the artifact 
(Figure 3-7). 
 
5 Select Save As in the File menu, type a name for the file. Choose a destination on the 
computer in which to save the file(e.g. the iWorx or class folder). Click the Save button 
to save the file (as an *.iwd file). 
 



 
Figure 3-7: The compound action potential. 
 
Exercise 2: Stimulus and Response 
 
Aim: To quantify the relationship between amplitude of the stimulus and amplitude of the 
compound action potential. 
 
Procedure  
 
1 Use the arrow buttons in the stimulator panel to change the stimulus amplitude to 0.00 
V (zero). Click the Apply1 button on the right of the stimulator panel to effect the change 
in the stimulus. 
 
2 If necessary, drain the crayfish saline from the nerve chamber, and carefully blot any 
large drops of saline from the recording electrodes and the nerve with the corner of a 
wipe. 
 
3 Click Start to stimulate the nerve with 0.00V. A flat line should be observed. Click Stop 
to display the last sweep on the Main window. 
 
4 Click the 1-Cursor icon in the LabScribe toolbar (Figure 3-8), type”0.00V” on the 
comment line to the right of the Mark button. Press the Enter key on the keyboard to 
attach the comment to the sweep. 

 
Figure 3-8: The LabScribe toolbar 
 
5 Use the arrow buttons in the stimulator panel to change the stimulus amplitude to 0.05 
Volts. Click the Apply1 button on the right side of the stimulator panel to effect the 



change in the stimulus. Click Start. After the trace appears, click Stop. On the recording 
window, there may be a small peak at the stimulus mark; this is the stimulus artifact. 
Type “0.05V” on the comment line, and press the Enter key to attach the comment to the 
sweep. 
 
6 Continue to increase the stimulus amplitude in 0.05V increments until a small 
compound action potential is observed. Remember: click the Apply1 button each time 
you want to effect a change in the stimulus; and, click the Stop button to record the 
sweep. This small compound action potential is the summation of action potentials from 
axons in the nerve with the lowest thresholds. Record comments in the same manner as 
before.  
 
7 Continue to increase the stimulus amplitude in 0.05V increments until the maximum 
compound action potential is observed. Change voltages, record sweeps, and record 
comments in the same manner as before. C fibers have thresholds and latencies up to 
30 times those of A fibers, so higher stimulus amplitudes and longer display times are 
required to see C fibers. 
 
8 Select Save in the File menu. 
 
9 Fill the nerve chamber with fresh crayfish saline to prevent dessication of the nerve. 
 
Data Analysis  
 
1 Click the ScopeView icon in the LabScribe toolbar (Figure 3-8 on page 
41) to view all the recorded sweeps. A single sweep or group of sweeps 
can also be selected for display from the Display Sweeps list. Sweeps 
can also superimposed on each other, for comparison, by checking the 
Stacked box 
 
2 Select Title, V2-V1, and T2-T1 from the Table Functions list. Start making 
measurements on the last recorded sweep, the one created by the highest stimulus 
amplitude. 
 
3 Click the 2-Cursor icon in the LabScribe toolbar. Drag the cursors left and 
right to place one on the baseline preceding the compound action 
potential (CAP) and the second on its peak (Figure 3-7 on page 41). The 
value for V2-V1 in the table at the top of the ScopeView window is the 
absolute amplitude of the CAP. 
 
4 Data can be entered into the Journal by either typing the titles and values directly or 
by using the right-click menu. Place the cursors to take measurements; then, select Add 
Title to Journal or Add Data to Journal from the right click menu to add the 
measurements to the Journal. 
 
5 Record the stimulus amplitude used to generate the nerve response along with the 
other data for the sweep in the Journal. 
 
6 Select the preceding sweeps from the Display Sweeps, and measure the absolute 
amplitude of each sweep. Record its value and the value of the stimulus amplitude used 
to generate the CAP in the Journal. 



 
7 Graph or tabulate the absolute amplitude of the CAPs as a function of the stimulus 
amplitude. 
 
Questions  
 
1 Does the action potential in a single axon increase in amplitude when the stimulus 
amplitude is increased? 
 
2 Does the amplitude of the compound action potential increase because more fibers 
are firing, or the amplitudes of the action potentials from single fibers are increasing, or a 
combination of both? 
 
3 How many fiber types did you observe in your monophasic recording of compound 
action potentials? 
 
4 The first peak of the compound action potential is composed of the responses of the 
fibers. How does the threshold and diameter of these fibers compare to other fibers? 
 
Exercise 3: Conduction Velocity 
 
Aim: To measure the velocity of action potential conduction 
 
Procedure  
 
1 Use the arrow buttons in the stimulator panel to change the stimulus amplitude to 0.25 
V or a voltage that produces a CAP with a maximum amplitude. Click the Apply1 button 
on the right of the stimulator panel to effect the change in the stimulus. 
 
2 If necessary, drain the crayfish saline from the nerve chamber, and carefully blot any 
large drops of saline from the recording electrodes and the nerve with the corner of a 
wipe. 
 
3 Click Start to stimulate the nerve. Click Stop to display the sweep on the Main 
window. 
 
4 Click the 1-Cursor icon in the LabScribe toolbar (Figure 3-8), Type "Long path” on the 
comment line to the right of the Mark button. Press the Enter key on the keyboard to 
attach the comment to the sweep. 
 
5 Move the lead cable for the negative recording electrode one or two electrodes closer 
to the ground electrode. Measure the distance (in mm) from the old position of the 
negative recording electrode to its new position. 
 
6 Click Start to stimulate the nerve. Click Stop to display the sweep on the Main 
window. 
 
7 Click the 1-Cursor icon in the LabScribe toolbar (Figure 3-8), Type”Short path” on the 
comment line to the right of the Mark button. Press the Enter key on the keyboard to 
attach the comment to the sweep. 



 
8 Fill the nerve chamber with chilled crayfish saline. 
 
9 Select Save in the File menu. 
 

 
Figure 3-9: Conduction velocity—two stacked traces. 
 
Data Analysis  
 
1 Click the ScopeView icon in the LabScribe toolbar (Figure 3-8 on page 41) to view the 
recorded sweeps. Select the last two sweeps recorded from the Display Sweeps list. 
Superimpose these sweeps on each other by checking the Stacked box. 
 
2 Select Title and T2-T1 from the Table Functions list. 
 
3 Click the 2-Cursor icon in the LabScribe toolbar. Drag the cursors to the peaks of the 
two compound action potentials (Figure 3-9 on page 41). The value for T2-T1 in the 
table at the top of the ScopeView window is the time it took the action potential to travel 
the distance between the two positions of the negative recording electrodes. 
 
4 Data can be entered into the Journal by either typing the titles and values directly or 
by using the right-click menu. Place the cursors to take measurements; then, select Add 
Title to Journal or Add Data to Journal from the right click menu to add the 
measurements to the Journal. 
 
5 Read off the T2-T1 value (0.0005s or 0.50ms in Figure 3-9 on page 44). 
 
6 Calculate the conduction velocity (in m/s). For example: 10mm distance between 
electrodes/ 0.5 ms = 20mm/ms = 20m/s 
 
Exercise 4: Conduction Velocity and Temperature 
 
Aim: To examine the effects of cooling on the velocity of action potential conduction 
 
Procedure  



 
1 Measure the conduction velocity of the nerve after draining the chilled crayfish saline 
from the chamber, as done in the previous exercise. 
 
Note: This part of the experiment must be done quickly since the nerve will begin to 
warm as soon as the bath is drained. 
 
2 Fill the bath with room temperature crayfish saline after data is recorded for this 
exercise. Allow the nerve to warm as you determine the conduction velocity of a chilled 
nerve. 
 
Questions  
 
1 Does the conduction velocity change when the nerve is cooled? 
 
2 What properties of the ion channels may change with temperature? 
 
Exercise 5: Bidirectionality 
 
Aim: To examine whether an action potential travels in the wrong direction and if so, at 
what velocity. 
 
Procedure 
 
1 Reverse the positions of the leads attached to the electrodes on the nerve bath. Put 
the stimulating electrodes on the distal end of the nerve where the recording electrodes 
used to be, and vice versa 
 
2 If necessary, drain the crayfish saline from the nerve chamber, and carefully blot any 
large drops of saline from the recording electrodes and the nerve with the corner of a 
wipe. 
 
3 Stimulate the nerve with the same amplitude used to record the last sweep 
 
4 Measure the conduction velocity of the nerve after draining the chilled crayfish saline 
from the chamber, as done in the previous exercise. 
 
Questions  
 
1 Do you record an action potential from the proximal end of the nerve? 
 
2 What is the conduction velocity for the nerve when stimulated in reverse direction? Is 
this similar to the value recorded when the nerve was stimulated from the proximal end 
to the distal end? 
 
3 How can an axon conduct as action potentials in both directions? Hint: Where are the 
cell bodies and synapses in this preparation? 



1. The crayfish nerve cord. 

The crayfish abdominal nerve cord has been widely investigated because of its relative 
simplicity. The cord consists of six ganglia (AB1 to AB6 in the figure) joined by 
connectives. From each ganglion, three bilateral (left & right) pairs of nerves ("roots") 
innervate the muscles and sensory receptors in that abdominal segment. (The sixth 
ganglion, nearest the uropods and telson, is a fusion of two embryonic ganglia.) Each of 
the three roots has a different destination in its segment of the abdomen, as described 
below. A supplement on the Anatomy of the Crayfish Nervous System has figures of 
stained neurons and spectacular videos showing serial sections through a ganglion.  



 



 


